SOX Check Approval FAQ

Read user guides for SOX Check Approval carefully in addition to reviewing this FAQ.

Note that SOX Check Approval is described in several documents, with each one intended for a
different kind of user.

e SOX Extended Payment Batch List User Guide is for users of Sage 300 who prepare
payment batches and submit them for approval using the Sage 300 Windows desktop.

e SOX Check Approval Console User Guide is for key users who will perform a 1, 2 or
3-step approval using the Windows-based approval console. These users may not be
familiar with Sage 300.

e SOX Check Approval Web Screens User Guide is for users who will approve
payments or who will submit A/P payment batches for approval using the browser-based
Sage 300cloud interface.

e SOX Check Approval Audit Report User Guide is for users who oversee the A/P

check process and want to print reports from the Sage 300 Windows desktop. The report

provides an audit trail for the approval of Sage 300 checks.

e SOX Check Approval Setup Guide is a document written for system administrators
who will install the software, set up databases, and configure the solution.

e SOX Check Approval Update Guide provides important information for system
administrators who are updating an installation from a prior version of SOX Check
Approval.

Installation and Upgrade Issues

Important Note: For versions prior to SOX Check Approval 2018-2021 (released Jan
2021), you must reinstall Desktop Menu Control on all computers where Check Approval is
installed after performing any Sage 300 updates.

SOX Check Approval updates the AP.INI file for Sage 300 when you install the Desktop
Menu Control. That’'s why you must reinstall the menu control after updating Sage 300 — to
ensure that the new AP.INI file includes the Check Approval changes.

Q: Where can | get release notes for SOX Check Approval, and what will they tell
me?

A: Click the Release Notes link in the upper left-hand corner of the SOX Check Approval
product page on the TaiRox web site. Among other things, the Release Notes will tell you
about recent fixes and provide program compatibility information. For example:

Build 2022-03-24

- Support for the Advanced Complex Passwords feature added in Sage 300
2022 PU2.

- Fixes an issue in the Basic workflow that under certain conditions
caused an approval level to be skipped.
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- Setup options have been grouped to separate system-wide settings from
company-specific settings.

Build 2021-10-13
- A new workflow, Basic, 1is added.

Q: ljustinstalled Check Approval, but the default Sage icons are all still there.
What happened?

A: If you just installed the new version of SOX Check Approval 2018-202n, you will not see a
change in the A/P icons. The new version of SOX Check Approval subclasses the A/P
Payment Batch List and Payment Entry programs to add functionality that forces batches to
be submitted for approval before you can print checks and post payments.

As part of the upgrade procedure to SOX Check Approval 2018-202n, you must Uninstall
the Desktop Menu control from all workstations that have a full install of Sage 300.

A2:If you are running “the classic” version of SOX Check Approval (for Sage 300
versions 2012-2017), you must install the Check Approval program and install the desktop
menu control on each computer where Sage 300 is physically installed. The Desktop Menu
control must be installed on all workstations that have a full install of Sage 300.

General Installation Notes:

Most SOX Check Approval users have one or more RDP servers and use workstation setup. Make
sure that you install the SOX Check Approval program and install the desktop menu control on all
RDP servers.

It may help to sketch out your Sage 300 and Check Approval installation.

e You require one (and only one) approval database for Check Approval.

e You need to activate Check Approval for each company using Check Approval.

e You need to install the Desktop Control on each computer that has a full install of Sage 300.

o If Check Approval 2012-2017 is active for the company, installation adds the new
Extended Payment Batch List function to the A/P Transactions menu and removes the Sage
300 Payment Batch List and Payment Entry functions.

Q: Why did the Extended Payment Batch List icon disappear from the A/P
Transaction folder?

A: Note that after January 2021, versions of the program that work with Sage 300 2018-202n
do not change the icons in the A/P Transaction folder.

If you are using a version of SOX Check Approval that was released before January 2021 —
or if you installed the version for Sage 300 2012-2017, note the following.

Did you just update Sage 300?

For older versions of SOX Check Approval, you must Install Desktop Menu Control on the Check
Approval Setup Installation tab when you install or update Sage 300 so certain Check Batch
operations can be blocked and the correct icons appear on the Accounts Payable folder on the Sage
300 desktop.

e Click the Uninstall Desktop Menu Control button before installing any Sage 300 updates. Then
click the Install button after the Sage 300 update is complete.
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Q: Why don’t | see everyone that | want to add as check approvers on the Users
tab?

A: All check approvers must first be added as Sage 300 users in order to appear on the Users
tab. In addition, all submitters and users must have an email address in the Email 1 field of
their Sage 300 user profile in order to be sent email notifications.

Q: ljust updated SOX Check Approval and got a message that the database
needs to be “created or converted.” What’s wrong?

Note: These messages can appear when you open the SOX Check Approval Console program or
when you open the A/P Payment Batch program or the SOX Check Approval Audit Report

Emor
Description: System emor. The Check Approval database needs to be created
System error. The Check Approval database needs to be or converted to the curent version, Contact your System Administrator
created or converted to the current version, Contact your
system Administrator, Source: 11:01:25-
it

A: These messages appear if you updated SOX Check Approval and you also need to update
the Check Approval database because of program changes.

For example, the April 2025 update required you to update the Check Approval program,
and then update the Check Approval database because database was changed in April
2025 to add the check batch approval date.

To update the Check Approval database:
e Sign on to Sage 300 as an administrator and open SOX Check Approval Setup.
e Select the Database tab.
e Click the Convert button.

System | Companyl Banks I Options I Data

o 5 e ]
|AUDTORG CNTBTCH DATEBTCH BATCHDESC CNTENTER BATCHSTAT  IDBANK BANKDESC CODECURN  RATETYPE RATEE‘

The program will display the following message:

The Check Approval database is at data level 4. You should
backup the Check Approval database before converting it to
data level 5. Are you sure you want to convert the Check
Approval database?

If you have backed up your database, click Yes to convert the data. The following message will
appear:

Message

Description: The Check Approval database has been converted from data
level 410 data level 5 successfully.

Source: 11:45:24 -

=
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Q: I moved all Sage SQL databases and the Approval database to a new SQL
Server and installed the latest versions of Sage modules and Cheque Approval
Desktop and Console on a new server.

All Sage modules appear properly, but | don’t see SOX Check Approval on the
Sage Desktop, and | get the following message when opening the Check
Approval Console. What’s the problem?

“heck Approval Console X

System error, The Sage 300 User has not been set up in Check
Approval Setup in Sage 300

oK

A: If Check Approval Setup does not show up on the Sage 300 Desktop, you need to install the
C/C++ runtime that is shipped with the SOX Check Approval installation files --
vcredist 2013 x86.exe.

As noted in the readme file “READ-WHY-NEEDED-vcredist 2013 x86.txt”, the C/C++
runtime required by SOX Check Approval may not be present on newer versions of
Windows such as Windows 10.

== SOXCheckApproval-2024-11-1t X ar
C Q> Search SOXCheckApproval-202¢  Q
% (18] = W T sort = View (8 Extract all (B Details
Na Compressed size Password .. Size
£ Home Name Compressed size assword ize Ratio
b | -2018- Wi ¢s Installer Packag 4821KB No 195KB &
ﬂGa\lery -8 Console-2018-2025 Installer kage KB 5195 KB
b.] Desktop-2018-2025 vs Installer Package 8,864 KB No 9,262 KB 5
OneDrive - Persc
READ-WHY-NEEDED-veredist_2013_x86 Text Document 1KB No 1KB 39%
I [W] veredist_2013_x86 Application 6146 KB No 6352KB 4 |
W Desktop »

You also need to copy the TaiRoxChgApproval.ini file from the old server’s Sage 300
SharedData Folder to the Sage 300 SharedData Folder on the new server.

R ER |
Home Share WView 0
« v » ThisPC » Drive2 (F) » Sage » 5age300 » SharedData » Company » L ] O Search Company
SetupWz G Mame Type Size ~
SharedData TaiRox Automate Recurring Entries 5/ File folder
TaiRox CRM File folder
Irdparty
TaiRox 50X Check Approval File folder
BXDATA .
userMgtlogs File folder
T {j TaiRox ChgApproval.ini Configuration settings 3KB

And you will need to update the Sage 300 User in Check Approval Setup — typically, the
ADMIN user —that’s used to authenticate check approvers when they log in to the Check
Approval Console.
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Issues with Email Setup

Q: I can successfully send a test email to my Gmail account from the SOX Check
Approval Setup program, but | get an email error message when | submit A/P
batches for approval, and email notification is not sent to approvers.

A: Check the port number for the Email Server on the Email Notification tab in SOX Check
Approval setup.

If it’s set to port 465 in Setup, the test will work properly, but email notifications will not be
sent from the Web Screens. Change the email port to 587, test the settings, then check that
it works with the Web screens.

All approvers must have an email address in the Email 1 field of their Sage 300 user profile.

Also check that your Gmail account is configured to allow access for less secure apps.

Q: How can | test email for the Web Check Approval Console. It doesn’t have a
choice to send a test email.

A: You can test the Web Check Approval Console email by installing the Classic Check
Approval Console on the web server, and then use the Classic Check Approval Console to
test email.

Q: How do I list multiple recipients for distribution lists or for sending test emails
from the Email Notifications tab?

A: Use commas or semicolons to separate email addresses if you need to enter more than 1.

Note that newer versions of SOX Check Approval (as of December 2022) do not use
distribution lists. The program uses the Email 1 email addresses stored in Sage 300 User
profiles.

Q: lam trying to set up email notification in TaiRox Cheque Approval, but | am
receiving the following error. | have checked many times, and the username
and password are correct. What’s wrong?

(X Error IL]E-
[ Index  Priority Description :
Authertication failed. Corfirm that the usemame and passw... | |
2 Emor System Emor. Send Test Email failed. See log file C:\Users\....

< m >

| Description: Authentication failed. Confirm that the usemame and password are

|comect.
|Source: 19:56:05 -
\

A. Confirm that the username and password are correct, and review the log file.
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For example, the following log extract suggests that 2-factor authentication is in place (and
the second factor has not been entered on the device where you are running SOX Check
Approval). If 2-factor authentication is on, you might read this article:

https://support.microsoft.com/en-us/account-billing/turning-two-step-verification-on-or-
off-for-your-microsoft-account-bla56fc2-caf3-abal-f7e3-4309e99987ca

readSmtpResponse:
SmtpCmdResp: 535 5.7.3 Authentication unsuccessful
[MWHPR21CA0063. namprd21.prod. outlook.com]
(leaveContext)
SMTP authentication failed after sending password.
office365 tips:
Your office365 account might be requiring MFA (multi-factor authentication).
Change your office365 account settings to allow single-factor authentication
(allow legacy authentication).
See https://docs.microsoft.com/en-us/azure/active-directory/conditional-
access/block-legacy-authentication
Also, you may need to create an App password.

Q: How do I turn on email logging and view the log file?

A: Select the “Enable Email Logging” checkbox on the System tab for SOX Check Approval
Setup. The logging option creates a technical email log that documents all of the
handshaking involved in communicating with an SMTP server. This feature helps you
diagnose setup issues, as well as ones that arise due to email providers’ changes.

Email Server Settings
Mail Server (SMTP)

Port Number (SMTF) 587

Connection Timeout (Seconds)
Enable 551
Account Name

Password

Mail From ‘nmrficaﬁuns@laimx.cum |

Reset Email Settings Send Test Email

You can find the email log file in:
>Sage300\SharedData\Company\TaiRox SOX Check Approval\Logs

Issues with A/P Check Batches

Q: I have AP check batches. Why do | get this message when | submit the
batches for approval?

Incorrect Procedure. Payment batch 712 has no payments or checks that need check approval.
Payment batch 712 does not need to be submitted for check approval.

A: Review the “Submit These Payment Types for Approval” option on the Options tab (or
Installation tab in older versions) for SOX Check Approval Setup. Older versions of Check
Approval only submitted transaction type “Check” for approval. (Check Approval allowed
other payment types in Oct 2020.)

Note that payment types are associated with payment codes, which can be assigned cash,

check, credit card, or other payment types. If you are submitting Check payment types only,
then Check Approval will not be involved if the type is “Cash” or “Other’.
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Also, changing the ‘Payment Type’ in Payment Codes after entering a transaction does not affect
existing Payment Entries. If you entered a payment that requires approval with the wrong payment
type, you must delete it, then re-enter it with the correct Payment Type.

Q: How can I return a batch to Open status that was submitted for approval?

A: The standard way to return a batch to Open status is to have an approver use the Check
Approval Console to return it to the submitter.

If you cannot return the batch to the submitter, an Administrator can return a batch to Open status by
removing the batch entry from the Approval database.

e Open the Check Approval Setup program on the Sage 300 desktop.

e Go to the Data tab, select Check Batches, and click the Load button.

System | Company I Banks | Options ~ Data | Database

Check Batches ~ Company |SAMLTD ~ | Batch (0for &ll batches)

Level 1 <Alls w | Level 2 <All> w | Level 3 <Alls w Load

AUDTORG CNTBTCH DATEBTCH  BATCHDESC CNTENTER ~ BATCHSTAT  IDBANK BANKDESC ~ CODECURN

(SRR 60 [ 20211012 | Paymenis not Approved for Batch 53 |1 |1 [CCB____|CanacinC_[CAD |

e Select the batch that you want to return to Open status, and press the Delete key.

e Click the Yes button to confirm the procedure.

Are you sure you want to delete batch 60 from the source
company SAMLTD?

tes

Q: We have batch that is “hung up” in the approval process. How can we reset it?

A: No matter why the batch became stuck, you can follow the instructions in the previous FAQ
“How can [ return a batch to Open status that was submitted for approval?” to return a batch
to Open status, and then resubmit it.

A batch can become “stuck” if you change the approval workflow (usually by reducing the number of
approval levels) after submitting the batch for approval.

Issues with the Check Approval Console

Q: Why do I get an Invalid Input or a Signon Failed message when | try to log in to
the Check Approval Console?

(‘Ermor =5 ) ===

g% Invalid input, User ID has not been assigned, Enter an existing user ID or {§%q Signon to Sage 300 failed. Error code = 70, Plesse ensure that Sage 300
L | ask your system administrator to add a new record for this user &' isinstalled correctly, that all Sage and third party licenses are current,

= ' that Windows Updates are installed, and that your Sage 300 Shared Data
folder exists and all required files within it are not corrupt.
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A: Invalid Input message can appear if the user ID you entered has not been added to Sage
300 or if the password you entered is incorrect.

If this is your first time signing in, check with a system administrator that the User ID has been added
in Sage, and confirm the password. (You can test the ID by signing on to Sage 300.)

A “Signon failed” message can appear if you were assigned a new Sage 300 ID that required
a password change on the first login.

If this is your first time signing in, you should sign in to Sage 300 first to ensure your ID works
properly, and then change your password if requested by Sage.

Q: How can | change my signon password for the Check Approval Console?
A: Your Check Approval Console ID and password were assigned in Sage 300.

Start Sage 300, then click the “Change Password” button when the Open Company signon screen
appears.

Q: Why do | get a message about “Integration with document management
software?

A: SOX Check Approval integrates with Altec DocLink and Orchid Document Management

Link, allowing check approvers to drill down to and examine source documents that have
been paid — mainly invoices.

When applicable, the Document Number column in the Console includes a button that you can click
on to launch a document management product to view the original source document.

Q: We submitted a Payment batch which shows Check Creation in Progress
status. It has been approved in Level 1, but it does not show up in the Check
approval console for any of the Level 2 approvers.

Here is our settings screenshot.

| Strict: All checks must be approved at all levels

Levels of Check Approval

Check Approval Level 1 Check Approval Level 2
Administrator Administrator

Carla Williams Carla Wiliams

[[] Den Fenske [] Den Fenske

[ Frank Wiliams ] Frank Wiliams

[] Jesse Munroe [] Jesze Murroe

Keith Smith Keith Smith

[] Wade Fischer [] Wade Fischer

A: You have the same approvers for level 1 and 2. If you want the same approvers for each

level (that is, you want each check approved by 2 people, in any order), you should use the
Simplified workflow.

e Simplified: Checks must be approved by a number of users. Choose this workflow when
each check requires more than one approver, but there is no hierarchy for approvers.

If a user approves a batch at level 1 — and the user is also a level 2 approver — the batch will be
approved at both levels.
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Q: I have a batch with a single payment that is not approved. How can | move the
batch along so itis no longer in the queue. | get an error when | try to approve
the batch without approving the entry.

®

File View Help

=~ Sample Company Limted (1} Payment Batch Information

. Prepayments - 2 Company [Sample Company Limited | Bateh Entries Date
Description  [Prepayments | Bank Canadian Commercial Bank

Toul Foproved Not sroved

Submited By |Administrator ] [morgan irox.com ]

Checks

Ent
Comment o er Tooe Mo Vendor/Payee Name

y» O Purchase not approved 1|Prepayment | 1400 Coastal Heating of Ottawa

Index Priorty Description

Payment Batch 66 has not been approved

A: Acknowledge the message, choose View > Refresh from the SOX Check Approval
Console, and then click the Return button. Type the reason for rejecting the payment.

SOX Check Approval doesn’t create new batches with rejected entries if no entries have been
approved.

Issues with Orchid Document Management Link

Q: Orchid DML works properly in A/P Invoice Entry and when | enter a payment in
TaiRox Extended Payment Entry. Why don’t the documents appear in the
Check Approval Console?

= TaiRox Check Approval Cansale =|o| x
Fle View Help
@ Fament fich dorsaicn

Congany Boich  [418] | Emes [0 Dme  [w2e2000 Poprve |

Descrptin [Banch 4161 Bank (108K DBk s,

Toal 009 (00 soprvnd 30 otfeomsd_| 0w

Boich 4172 2
Botch 4181 -2

Eay oo Vel ersor s 1033
) dopeed  Cormart Horeer Ty [

v O 1 Pamert

[ oo

A: Check that the user (network user account) running the TaiRox SOX Check Approval
Console has read access to the network fo/derwith the A/P documents.

Use a UNC path to the A/P document drive if running the console from a different server from where
you run Sage 300.
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Issues with the Audit Report

Q: How can | generate an Audit Report?

A: You can generate an audit report by running the Sage 300 Desktop, opening the SOX
Check Approval folder, and choosing the “Check Approval Audit Report” icon.

» Purchase Orders ~
I SOX Check Approval | SOX Check Approval (Check

> TaiRox CRM and Collections Approval Audit Report)

™ TaiRox Productivity Tools Licensed to: Don Thomson, TAIROX SOFTWARE INC
Accounts Payable Tools Dealer: TAIROX SOFTWARE INC
Accounts Receivable Tools
General Ledger Tools O g
Inventory Contrel Tools ]
Multi-Company Tools Checl;issro\ral CheckARpe;;rDo;alAudlt
Order Entry Tools
Payroll Tools e

s@' For Help, press F1 Session Date: 2022-04-05

Q: The Check Approval Audit report (and the Extended Payment Batch “In
Progress” popup) show blank approval dates. What’s wrong?

A: If you recently updated the SOX Check Approval database and have batches approved from
before you updated to the April 2025 version, these batches will not show approval dates on
the Check Approval Console screens or on the Check Approval Audit report. The dates will
appear only for batches that were approved after SOX Check Approval was updated (i.e.
after April 2025).

Issues with Viewing the Web Screen Audit Report

Q: The menu choice for the Audit Report does not appear on my screen. What’s
Wrong?

A In order for the Audit Report to show on the Web desktop, a user must have been granted
the Audit Report security rights as well as be able to view AP payment batches (Payment
Batch Inquiry, Payment Batch Entry, or Payment Batch Posting).

Q: My browser displays the following error message when | generate an Audit
Report. What’s Wrong?

[

localhost is blocked

@ 56rver Nave been Bocked by an ex%ension
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A: The Check Approval Console generates an audit report in PDF format that needs to be
downloaded to some browsers in order to be viewed

Some browsers will let you view the PDF directly, but others will not. Follow the instructions
listed below to download PDFs for Edge and Chrome. You can then open the downloaded
PDF files.

PDF download settings in Microsoft Edge
e Choose Settings from the Edge menu.

e Select Cookies and Site Permission.

e Scroll down and select “PDF Documents”.

e Turn on “Always open PDF files externally.

Settings 4 <

Site permissions / PDF documents

PDF download settings in Google Chrome

e Choose Settings from the Edge menu.

e Select Privacy and security.

e Scroll down and select “Site Settings”.

e Scroll down and expand “Additional content settings”.
e Select “PDF documents”.

e Turn on “Download PDF files instead of automatically opening them in Chrome”.

- T 0.

Issues with Viewing Approval Dates and Times in the Database

Q: The Approval Dates and Times in the Approval database are out by several
hours. What’s Wrong?

S‘,lstem] Company ] Banks I Options ] Data Database l

Tables | APETA || Create Drop Company | v| Batch | D|{Dforallbatches}

Load
COUNT1 AMTENTER DECCURN SUUBNAME SUBEMAIL WRITECOUNT  DATEA1 DATEAZ DATEA3
4/16/2025 4:07:58..._| 4/16/2025 4:11:52 PM

A The Dates and Times are stored in UTC (Coordinated Universal Time) and displayed on the
audit report according to the time zone of the current user.
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